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Estimado Cliente,

Gracias por elegir un sistema de guía DigiTrak. Estamos muy orgullosos del equipo que hemos estado
diseñando y produciendo en el Estado deWashington desde el año 1990. Estamos comprometidos a
suministrarle un producto excepcional, de alta calidad y respaldado con un servicio y capacitación al cliente
de calidad superior.

Por favor, disponga de unos momentos para leer todo el manual, especialmente la sección referente a
seguridad. Por favor, también registre su equipo en línea en access.DigiTrak.com. O llene por favor la tarjeta
de inscripción del producto para su equipo, y envíela por fax al 253-395-2800 o por correo a la casamatriz de
DCI.

La inscripción de este producto le da derecho a apoyo telefónico gratuito (en los EE.UU. y Canadá), a
notificación de actualizaciones del producto y nos ayuda a proporcionarle información de futuras mejoras del
producto.

Nuestro Departamento de Servicio al Cliente está disponible las 24 horas día, los 7 días de la semana en los
EE.UU., para ofrecerle ayuda con sus problemas o preguntas. En este documento y en nuestro sitio web se
encuentra la información de los contactos internacionales.

Mientras crece la industria de perforación direccional horizontal, nosotros estamos muy atentos al futuro
para desarrollar el equipo que le hará su trabajomás rápido y más fácil. Visítenos en la línea, en cualquier
momento, para ver qué hay de nuevo.

Son bienvenidas las preguntas, comentarios e ideas.

Digital Control Incorporated
Kent, Washington
2017

Vea nuestros videos DigiTrak de capacitación en www.youtube.com/dcikent

http://access.digitrak.com/
http://www.youtube.com/dcikent
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Instrucciones de seguridad importantes

Opere siempre su sistema de localización DigiTrak en forma correcta para obtener precisión en las
mediciones de profundidad, inclinación, balanceo y puntos de localización. Si usted tiene alguna pregunta
acerca de la operación del sistema, por favor póngase en contacto con el Departamento de Servicio al
Cliente de DCI, para obtener ayuda.

Estemanual es un compañero de sumanual del operador del sistema de guía Falcon F5®, el cual contiene
una lista más exhaustiva de advertencias relacionadas con el potencial de lesiones severas y muerte,
retardos en el trabajo, daño a la propiedad y otros riesgos y advertencias relacionadas con la operación del
equipo de perforación horizontal. Por favor, lea y comprenda completamente sumanual del operador del
sistema antes de operar el equipo descrito en estemanual.

No se garantiza que los datos registrados, visualizados, almacenados y utilizados por el
localizador Falcon F5 y el software LWD 3.04 sean exactos o completos. Se requiere revisión y
juicio humano. La precisión y la integridad de los datos generados por los sistemas de guía de
HDD pueden verse afectados por la interferencia activa o pasiva y otras condiciones
ambientales, la falta de calibración o utilizar el dispositivo correctamente, o una variedad de
otros factores. DCI no asevera o garantiza, ni asume responsabilidad alguna por la precisión,
integridad de los datos generados por cualquier fuente externa, incluyendo (sin limitación), los
datos de GNSS y los datos recibidos desde cualquier equipo de perforación.

Compatibilidad
LWD 3.04 puede abrir la mayoría de los trabajos guardados en versiones anteriores de LWD. Sin embargo,
los archivos LWD 3.04 (extensión lwd) no son compatibles con versiones anteriores de LWD 2.12, que
utilizan archivos con la extensión dl5. Además, los datos de iGPS no semostrarán en LWD 3.02. Un archivo
antiguo que se abre y se guarda en LWD 3.04 se convierte en un archivo lwd que ya no se puede abrir en
versiones anteriores de LWD. Póngase en contacto con el Servicio de Atención al Cliente de DCI para
obtener información sobre la actualización del software 2.12 ó 3.02 a la versión 3.04.

LWD 3.04 no es compatible con archivos heredados de F5 TensiTrak, archivos de presión de fluido
TensiTrak o archivos generados por un localizador Eclipse oMark Series. Para ver estos archivos
heredados, continúe usando LWD 2.12.
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Falcon F5 DataLog

La función DataLog® le permite capturar y almacenar los datos de cada barra en túnel piloto. Cuando se
utiliza con la aplicación de teléfonomóvil LWD Mobile, el uso de DataLog durante la perforación le permite
ver en tiempo real el desarrollo de la perforación en el teléfono, así como la ubicación geográfica de entrada y
salida. Si se utiliza el repetidor DigiTrak Aurora, la aplicación LWD Live también le permite ver el perfil de
perforación en tiempo real cuando se completa cada barra, independientemente de tener habilitada o no la
función DataLog.

Además de los datos de barras que DataLog siempre ha capturado, con el F5 Falcon hemos añadido
funciones adicionales como izquierda/derecha offset y desviación, que le permite grabar conmayor detalle
los puntos significativos circundantes. Estos datos son requeridos por el cliente para asegurar que los
parámetros de la perforación fueron cumplidos. Cuando importa su trabajo DataLog en el software Log-
While-Drilling (LWD) 3.0 para su PC, puede editar, anotar y crear el informe preciso que usted o su cliente
requieren.

Introducción
La función DataLog puedemedir y grabar los siguientes tipos de datos:

l Número de varilla
l Profundidad
l Inclinación
l Desplazamiento
l Desviación de la línea de ejecución
l Banderas y alfileres
l Cambio de elevación (topografía de la superficie)
l Presión del fluido (requiere de un transmisor de presión del fluido)

Los términos y técnicas utilizados en estemanual son considerados básicos para el sistema de localización
Falcon F5 DigiTrak. Usted debe leer y comprender sumanual del operador del sistema y familiarizarse con
los diferentes menús DataLog en su localizador antes de utilizar el sistema. Si tiene preguntas, por favor
llame al Servicio al Cliente de DCI para obtener ayuda.

Cómo funciona todo
La conversión del trabajo de su HDD en una gráfica LWD concisa, consiste de los siguientes pasos, que se
tratan en detalle más adelante en este documento.

Antes de cargar un DataLog de su localizador por primera vez, necesitará instalar LWD 3.04 en su PC, junto
con los controladores de radio Bluetooth (mini Falcon), e introducir el número de serie del localizador y la
identificación del Bluetooth.

1. Habilitar DataLog en su localizador (se envía desde nuestra central en ON (HABILITADO), en
forma predeterminada).

2. Cree un nuevo trabajo, configure el desplazamiento, la desviación opcionales y comience a grabar.

3. Registre las varillas completas o parciales, saque las varillas o inserte las banderas o alfileres
antes de pausar o cerrar el trabajo.
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4. Seleccione el trabajo para cargar desde su localizador, luego:
l Cargue del interior de LWD 3.04 y anote o edite los datos del trabajo según sea necesario,
o

l Cargue a su dispositivo inteligentemóvil mediante LWD paramostrar todos los datos de
perforación e incluso el perfil de perforación, en un formato de sólo lectura, en su
dispositivo.

5. Si cargó a su dispositivo inteligente, necesita una suscripción para transferir el trabajo a su cuenta
de DigiTrak Cloud (opcional). Una vez allí, se puede acceder y editar en LWD 3.04, desde
cualquier computadora con acceso a Internet.

Para vincular su localizador a una cuenta en la nube y administrar las suscripciones, vaya a
www.MyDigiTrak.com.

Descargue la aplicaciónmóvil gratuita LWD para su dispositivo inteligente, desde Apple Store oGoogle Play
y lea la guía del usuario situada en los manuales del operador, en el sitio web de Falcon F5. Consulte en
línea nuestra página de Aurora, para obtener más información sobre la aplicación LWD Live.

DigiTrak DataLog Management (DDM)
DataLog y Log-While-Drilling son parte del proceso completo de gestión de datos de DCI. Paramás
información visítenos en línea.

En la página Documentation (Documentación) de nuestro sitio web Service & Support > Documentation
(Servicio y Apoyo > Documentación), enManuals (Manuales), seleccione Falcon F5 en el menú desplegable
y desplácese hasta la sección de las Guías del Usuario relacionadas, para obtener información sobre:

Cloud Manager Almacene y administre sus archivos DataLogs y Log-While-Drilling
(LWD) desde todos sus localizadores en un solo lugar conveniente.

iGPS Agregue las coordenadas de latitud y longitud GNSS a cada punto de
datos con estemódulo opcional complementario de Falcon F5.

LWD Live Mire su perforación trazada en tiempo real en su pantalla táctil Aurora .
Importe un archivo Vermeer BoreAssist.

LWD Mobile
Utilice su teléfono inteligente para cargar un trabajo Falcon F5
DataLog en su cuenta de nube de suscripción para una visualización y
análisis inmediatos en toda la empresa.

Ajustar la hora y el calendario
Antes de registrar datos, debe ajustar la fecha y hora correcta en su localizador. La opción para ajustar la
hora y el calendario está disponible en la opción deSettings (Configuraciones) en el menú principal. Para
obtener ayuda adicional en el ajuste de la hora y fecha para su localizador, consulte sumanual del operador.

http://www.mydigitrak.com/
http://www.digitrak.com/component/content/article?id=271:falcon-f5-manuals
http://www.digitrak.com/CustomerService/Downloads
http://www.archive.digital-control.com/support/WebHelp/DataLogLWD-OM-TL/Spanish/Default.htm
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Componentes del sistema
El sistemaDataLog DigiTrak tiene cuatro componentes principales:

Localizador Falcon F5 (FF5) Un receptor (localizador) conmenús DataLog usados paramostrar y
grabar los datos del transmisor.

Transmisor Falcon Un dispositivo energizado por medio de una batería, ubicado en el
cabezal de perforación, con sensores quemiden y transmiten
continuamente información acerca del cabezal de perforación que se
encuentra por debajo del suelo. Esta información semuestra en el
localizador FF5.

Software LWD 3.04 La aplicación de computadora usada para descargar y trabajar con los
datos de perforación Falcon F5 DataLog de un localizador.

Radio USB para Bluetooth Un dispositivo USB necesario para que la computadora se comunique
con el localizador Falcon F5. Busque laminiatura Falcon F5 en el
estuche del sistema.

Localizador
El localizador rastrea la posición y la profundidad del transmisor. Cuando DataLog está activado, también
graba los datos de perforación, tales como profundidad, inclinación y el número de varilla. El localizador F5
puede grabar y almacenar 50 trabajos (tramos) antes de que alguno o todos los trabajos deban ser
eliminados para crear espacio para trabajos nuevos. Cada trabajo DataLog puede tener cientos de puntos de
datos.

Transmisor
El localizador Falcon F5 funcionará solamente con un transmisor Falcon. La tecnología avanzada, utilizada
en el sistema Falcon, hace que el localizador sea incompatible con los transmisores clásicos de DigiTrak.

Los datos de perforación estándar provistos por un transmisor incluyen la profundidad y la inclinación. El
transmisor Falcon F5 también proporciona lecturas de presión de fluido.

Software LWD
El software Log-While-Drilling (Registro-al-Perforar, LWD) es suministrado en una unidad flash USB, que
contiene también estemanual del operador, el manual del operador del sistema, datos muestra de
perforación y controladores Bluetooth.

Unidad flash USB LWD 3.04

El software requiere de una computadora con las siguientes especificaciones mínimas:

l Los sistemas operativos Microsoft Windows soportados actualmente por Microsoft Corporation
l Puerto USB
l Dispositivo señalador (ratón)
l Impresora (opcional)
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Radio USB para Bluetooth
El radio USB para Bluetooth se conecta en su computadora para permitir que el localizador cargue los datos.
Los controladores para el adaptador Bluetooth son proporcionados en la unidad flash LWD y deben cargarse
antes de usarse; ver Log-While-Drilling 3.04 (Registro-al-Perforar) en la página 25.

1. Estuche
2. Radio

Radio USB para Bluetooth

Informe típico LWD
El informe incorporado que usted ve en el programa Log-While-Drilling (Registro-al-Perforar) muestra los
datos de perforación que grabó en su localizador Falcon F5. Todos los informes incluyen datos del
transmisor estándar, como el número, la profundidad y la inclinación de las varillas. Esta pantalla se discutió
en detalle en Apertura de archivos en la página 29.

DataLog con presión del fluido en LWD 3.04
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Personalice las opciones durante la perforación con el localizador Falcon F5:

l Desviación de la línea de ejecución
l Desplazamiento de la trayectoria de una línea de ejecución o de un punto de referencia paralelo, tal como
una barandilla, guarnición o cerca

l Alfileres paramarcar puntos geográficos adyacentes a la trayectoria de perforación
l Banderas paramarcar los cruces de servicios públicos
l Elevación del punto de salida

Personalice las opciones después de descargar a la computadora:

l Agregar los servicios públicos por código de color, tipo y profundidad
l Agregar características como carreteras, agua y postes de energía usando anotaciones
l Agregar, eliminar omodificar las varillas y las longitudes de varilla
l Dibujar a escala la gráfica para que se veamás realista
l Agregar un punto demedición paramostrar la diferencia de elevación entre las elevaciones de la entrada
y de la salida.

l Dibujar a escala la gráfica para ocultar los datos de presión
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Utilización de DataLog en el Falcon F5

Para grabar los datos de la perforación piloto, el localizador debe estar recibiendo datos desde un transmisor
debidamente emparejado y calibrado, tal como se describe en el manual del operador del localizador.

Activar DataLog
La función DataLog debe ser activada antes de que usted pueda iniciar la grabación o anexar los datos de
perforación.

Del Menú principal, conmute hacia abajo a la segunda página y seleccioneDataLog .

Segunda pantalla del menú principal del localizador Falcon F5

En el subsiguientemenú DataLog (siguiente sección), si el icono DataLog está rojo (desactivado),
selecciónelo y cambiará a verde (activado). Si el icono ya está verde, DataLog ya está activado.



DIGITAL  CONTROL  INCORPORATED

8 Manual delOperador LWD 3.04 DigiTrak

Menú DataLog del localizador
Utilice el menúDataLog para activar o desactivar DataLog, configurar un trabajo, eliminar trabajos y llevar a
cabo otras tareas con DataLog.

Segunda página

1. Configurar trabajo
2. Cargar
3. Eliminar
4. Activar / Desactivar
5. Punto de medición
6. Ver trabajos
7. Activar / desactivar el

desplazamiento izquierdo /
derecho de la trayectoria de
perforación

8. Activar / desactivar la
desviación de la trayectoria
de perforación prevista

9. Salir

Menús DataLog

Los íconos Desplazamiento izquierdo / derecho y Desviación se encuentran debajo del ícono Activar /
Desactivar . Seleccione uno de los iconos para activar cada función(verde) o desactivar (rojo, mostrado
arriba). El desplazamiento y la desviación se discuten en la página 17.
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Crear un trabajo nuevo
1. En la pantalla Locate (Localizar), mantenga el gatillo presionado y conmute a la derecha para

mostrar el menúDrill DataLog Start Recording (Iniciar grabación de DataLog de perforación)
(que es lomismo que seleccionarSet up job (Configurar trabajo) del menúDataLog del
localizador).

2. SeleccioneCrear un trabajo nuevo .

1. Crear un trabajo nuevo

Menú de grabación DataLog

3. Introduzca en el teclado la longitud de la varilla de perforación (tubería) que se utilizará para este
perforación, a continuación, seleccioneAceptar para establecerla como la longitud de la
varilla de perforación.

1. Aceptar

Teclado para introducir la longitud de la
varilla

La longitud predeterminada de la varilla es 3m. El localizador recuerda la longitud de su última varilla.
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4. Aparece la pantalla de entrada de la longitud de la primera varilla con un valor predeterminado. Esta
longitud se calcula automáticamente como un 70% de la longitud de su tubería. Si esto es correcto
para su perforación, seleccione para fijar este valor y vaya al paso siguiente.

1. Longitud de la primera varilla
2. Establezca la longitud de la

primera varilla al valor
predeterminado

3. Seleccione el teclado para
introducir un valor diferente

Pantalla de entrada de la longitud de la
primera varilla

Si el cabezal deperforaciónno sepuedecolocar demodoque las ranuras estén lamitadpor encima
y lamitadpor debajo del terrenodebidoa la configuracióndel herramental deperforación (tal como
semuestra en las ilustraciones anteriores y posteriores), todavía sepuede ilustrar estomás
adelante enLWD ensus datos deperforación cargados, al abrirJob Information (Informacióndel
trabajo) (enel menúEdit (Editar)) e introduciendounvalor en la casillaRel. Elev. (Relative
Elevation) At Entry (Elev. Rel. (Elevación relativa) en la entrada). Por ejemplo, si las ranuras de la
caja están1.2mpor debajo del suelo, introduzcaunvalor de -1.2.

Para calcular un valor de longitud diferente de la primera varilla, mida desde las abrazaderas de la parte
superior de la varilla, cuando el cabezal de perforación se coloque para el primer punto de datos. Para
estamedición, las ranuras de la caja deben estar, la mitad por encima y lamitad por debajo del suelo (o
de un plano paralelo al suelo, si se está perforando en un pozo). La elevación en el primer punto de
datos es la elevación de referencia cero, y está generalmente en la superficie del terreno.

Seleccione el teclado, introduzca el valor deseado y seleccioneAceptar .

1. Carro de perforadora
2. Parte superior de la varilla
3. Longitud de la primera varilla
4. Abrazaderas
5. Ranuras en la caja
6. Línea de referencia de

elevación cero
7. Superficie del terreno

Medición de la longitud de la primera varilla



DIGITAL  CONTROL  INCORPORATED

Manual delOperador LWD 3.04 DigiTrak 11

5. Al grabar el primer punto de datos (varilla 0), la única opción disponible seráGrabar inclinación

solamente . Con el localizador colocado dentro del alcance del transmisor (no tiene que estar en

la línea de localización o en el punto de localización frontal), seleccione para grabar el punto de
datos.

Nota iGPS

Es mejor registrar la varilla 0 por encima del transmisor en la entrada (# 5 arriba). Grabe todos
los puntos de datos de iGPS con el Falcon F5 por encima de la línea de localización (LL) para
garantizar los registros GNSS adecuados.

1. Las – – – indican que el
desplazamiento está
desactivado

2. Grabar inclinación solamente

Opciones de grabación de DataLog de
perforación (Inclinación solamente)

6. Si la Desviación está activada (ver página17), seleccione las flechas para introducir la distancia
horizontal a la que está localizado el cabezal de perforación (está predeterminada la última
desviación ingresada), luego seleccione para guardar y regresar a la pantalla Locate
(Localizar).

7. Avance el cabezal de perforación hasta el extremo de la primera varilla y coloque el localizador
sobre la línea de localización (LL) o sobre el punto de localización frontal (FLP). Mantenga el gatillo
presionado para tomar una lectura de profundidad y configurar un punto de referencia.

Nota iGPS

Los datos GNSS serán más precisos cuando se graben los datos con el localizador sobre la línea
de localización. Al grabar los datos de la varilla en el FLP se almacenarán los datos GNSS, pero
quedarán ocultos en el informe LWD. Esto se debe a que los datos GNSS en el FLP no están por
encima de la línea de localización, pero las profundidades en el FLP se calculan de nuevo para
reflejar la profundidad sobre el cabezal de perforación. Después de transferir el trabajo DataLog
a LWD en una computadora, usted tendrá la opción de mostrar los datos GNSS en el FLP.
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8. Mantenga presionado el gatillo y conmute hacia la derecha una vez para ver las Opciones de
grabación, que ahora cuenta con todas las opciones activadas.1

1. Grabar la profundidad /
inclinación (mostrada con la
mejor calidad de señal iGPS)

2. Grabar inclinación solamente
3. Grabar una varilla en blanco

Opciones de grabación de DataLog de
perforación

Cuando aparece esta pantalla, los datos del transmisor y del iGPS están bloqueados y usted puede
mover el localizador. Estos datos permanecen visibles hasta que usted graba estos datos o selecciona
Salir. Antes de grabar, verifique que el número de varilla, profundidad, inclinación y desplazamiento
sean los correctos. Si no, conmute hacia abajo, seleccioneSalir (nomostrada arriba) y repita este
paso.

Nota iGPS

Si no hay iconos (o luces LED en el módulo iGPS) verde sólido, salga y obtenga una mejor señal
GNSS. Intente permanecer en la posición más tiempo o coloque su cuerpo en un lado diferente
del localizador.

9. Seleccione uno de los siguientes para grabar el segundo punto de datos (varilla 1):

l Grabar profundidad / inclinación para registrar la profundidad, inclinación y (con el módulo
iGPS opcional) la información GNSS.

l Grabar inclinación solamente para registrar sólo la inclinación porque usted no puede
colocar el localizador en LL o FLP. Esto también es útil cuando se perfora por debajo de varillas de
refuerzo, lo cual puede resultar en valores de profundidad y topografía incorrectos en la gráfica.

l Grabar una varilla en blanco si no tiene datos debido a que no se puede colocar el
localizador dentro del alcance del transmisor. Esto es especialmente útil para cruces de autopistas
y cruces de corrientes de agua.

1 Este paso se puede hacer desde la pantalla Locate (Localizar) estándar o desde la pantalla de Direccionamiento por objetivo
(Target Steering). No esnecesario conmutar la pantalla de Direccionamiento por objetivo para estas funcionesde DataLog.
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10. Opcional: Si la desviación es activada (ver la página 17), introduzca la desviación izquierda o
derecha o un espacio en blanco, después de lo cual el localizador regresa a la pantalla Locate
(Localizar).

11. Continúe perforando, usando el gatillo / la secuencia de conmutación a la derecha, para grabar los
puntos de datos y la desviación al extremo de cada varilla de perforación.

Resolución de datos faltantes

Si el localizador no puede ser colocado por encima del cabezal de perforación (LL) o en el FLP mientras se
conmuta hacia la derecha para grabar una varilla, la opciónGrabar profundidad e inclinación no estará
disponible y sólo se podrá grabar la inclinación. En la gráfica LWD de su computadora, una lectura de
inclinación solamente producirá una brecha en la topología donde falte la profundidad, peromantendrá la
representación gráfica precisa para el perfil inferior de la perforación.

Nota iGPS

El GPS no es grabado para las grabaciones de inclinación solamente, y en blanco.

LWD sugerirá una profundidad estimada basada en la topología circundante, que usted puede aceptar o
anular con su propio valor en LWD. Después de cargar los datos, haga clic con el botón derecho del ratón en
esa varilla en la tabla de datos, seleccione Edit (Editar) y desactive la casilla de verificación "Depth is
Hidden/Unknown" (Profundidad oculta / desconocida). Para las varillas grabadas en blanco, la profundidad e
inclinación faltante pueden calcularsemediante el software LWD o puede ingresar manualmente la
inclinación adecuada, si se conoce. Ver Edición de los puntos de datos en la página 36.

Grabación de varillas parciales
El programaDigiTrak Log-While-Drilling (LWD) requiere puntos de datos que deben ser grabados a intervalos
igualmente espaciados, tal como en el extremo de cada varilla de perforación. Sin embargo, cuando se
perfora con varillas de perforación largas y / o se hacen cambios de inclinación importantes, es posible que
usted desee grabar datos en intervalos parciales de longitud de la tubería para describir conmayor precisión
el perfil de la perforación y los cambios en la topografía. La función LWD puede admitir longitudes de tubería
de un cuarto, mitad, tres cuartos y completa. Las varillas parciales sólo podrán ser grabadas después de que
la varilla 1 (segundo punto de datos) haya sido grabada.

Para grabar una varilla parcial o sólo la inclinación de lamisma:

1. Coloque el localizador en el FLP, o sobre la LL o dentro del alcance del transmisor para la
inclinación solamente.

2. En la pantalla Locate (Localizar) mantenga el gatillo apretado y conmute a la derecha una vez para
ver el menú de grabación.

3. Conmute hacia abajo y seleccioneDatos en varilla parcial en la segunda página.
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1. Longitud de la varilla
(completa, ¼, ½, ¾, o
terminada, en función de si se
ha seleccionado una varilla
total o parcial)

2. Datos en varilla parcial

Menú de grabación DataLog

4. Seleccione una longitud de varilla parcial.

Pantalla de varilla parcial DataLog

La visualización regresa a la primera pantalla de opciones de grabación, pero el valor parcial de la varilla
(¼, ½, ¾, o varilla terminada) aparece en lugar de "Full Rod" (Varilla completa) (ver imagen en el
paso 3).

5. Seleccione la opción para grabar el punto de datos con la profundidad y la inclinación (grabe sólo la
inclinación si usted no puede colocar el localizador en la posición LL o FLP). Grabe la desviación, si
corresponde. El localizador regresa a la pantalla Locate (Localizar).

6. Grabe otro punto de datos en la longitud de varilla parcial o en el extremo de la varilla.

La opción "Finish Rod" (Terminar varilla) aparece si una varilla parcial fue grabada previamente.

Banderas y alfileres
Configurar una bandera o un alfiler para incluir un punto de referencia o información de servicios públicos con
sus datos de perforación (ver el diagrama en la página 18). Banderas y alfileres aparecen en la parte superior
de la gráfica LWD. Vea el dibujo al final de esta sección, para una ilustración sobre el uso de banderas y
alfileres.
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Conmute brevemente a la derecha en la pantalla Locate (Localizar) para configurar una bandera
o un alfiler. No oprima el gatillo para esta función. Un anuncio de "hold toggle right" (mantenga
el gatillo y conmute a la derecha) es el acceso directo para cambiar las bandas de frecuencia
del transmisor.

Menú de banderas / alfileres para DataLog

Las banderas están numeradas secuencialmente comenzando en la #1 y están ligadas a un número de
varilla específico. Los alfileres también se ligan a una varilla específica, pero usted ingresa su propio número
personalizado de alfiler. Tanto las banderas como los alfileres se deben ingresar antes de completar la varilla
actual.

La posición lateral de los alfileres y de las banderas se basan en el punto en el que se inició el número de
varilla LWD actual, en función de la línea de localización y no del FLP. Incluso si se ha grabado una parte de
esa varilla, la bandera / alfiler se posicionará desde el inicio de esa varilla.

Comenzando con la varilla 1, cada varilla en un archivo LWD muestra la distancia X (véase diagrama en la
página 22), que se calcula desde la entrada hasta el final de cada varilla.

En el informe impreso para las banderas y los alfileres, cada uno recibirá una Distancia X, por lo que se
puede comparar con las lecturas de profundidad en el informe.
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Banderas

Configurar unaBandera al cruzar cualquier elemento de interés a lo largo de la trayectoria de
perforación, como una acera, línea de servicios públicos marcada, o la ribera de un río. El localizador asigna
internamente un número secuencial de bandera que inicia en 1. Introduzca la distancia aproximada junto a la
varilla actual; este número siempre serámenor que la longitud de una varilla, de otra manera sería asignada a
la siguiente varilla. El localizador calculará la distancia horizontal total de la bandera en base al número total
de varillas ya registradas. Se requieren detalles manuscritos para que puedan ser ingresados en LWD
después de la descarga.

Pantalla de configuración de bandera

Alfileres

Configure unAlfiler paramarcar la ubicación de puntos de interés del terreno, a la izquierda o a la
derecha de la perforación, tal como un hidrante contra incendio o un poste de energía que pueda ayudar a
localizar posteriormente la trayectoria de perforación. La configuración de un alfiler requiere de tres
elementos de información, que se ingresan usando el teclado de pantalla:

1. Un número de identificación. Elija un número, cualquier número. Cree sus
propios códigos personalizados, tales como 11.xx para las hidrantes para
incendio, 22.xx para los postes de alumbrado, 33.xx para los postes de
semáforo, y así sucesivamente.

2. La distancia aproximada a lo largo de la varilla actual.

3. Qué tan lejos está el cabezal de perforación, a la izquierda o a la derecha de
la característica.
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Desplazamiento y Desviación
Tanto el desplazamiento y la desviación (ver diagrama a continuación) están desactivados (rojo) cuando
usted habilita DataLog. Para activar cualquiera de las características, simplemente seleccione el icono para
que cambie a verde. Los valores de desplazamiento y desviación se enumeran en la tabla de datos, pero no
se representan en la gráfica.

Desplazamiento

En el menúDataLog el Desplazamiento le permite especificar una distancia horizontal determinada
que usted pretendemantener de una característica a un lado y paralela a la trayectoria de perforación, tal
como una guarnición, barandilla, o trayectoria determinada. Un desplazamiento a "la derecha" significa que
la trayectoria de perforación prevista está a la derecha de la característica. Considere esto como un "punto
de referencia móvil" que se registra si el desplazamiento está en efecto. Use el teclado en pantalla para

introducir un valor, seleccione la flecha a la Izquierda oDerecha y después Aceptar.

El desplazamiento se puede activar o desactivar y ajustar a diferentes distancias en cualquier
número de varilla. Por ejemplo, un desplazamiento de la guarnición puede comenzar en la
varilla 7 a una distancia de 3m a la izquierda y terminar en la varilla 27. Un nuevo
desplazamiento de un borde de carretera puede comenzar en la varilla 50 a 1.5m a la derecha y
prolongarse hasta el final de la perforación.

Desviación

Asi mismo, en el menúDataLog, Desviación le permite marcar cuanto se está desviando el cabezal de
perforación de la trayectoria de perforación prevista. Una desviación "a la derecha" significa que el cabezal
de perforación está a la derecha de la trayectoria de perforación prevista. No introduzca una desviación
basada únicamente en la distancia de un punto de localización frontal a la izquierda o a la derecha de la
trayectoria de la perforación.

Cada vez que registra una varilla en la pantalla Locate (Localizar) (sostener el gatillo, conmutar a la derecha),
esta función le permite también registrar su desviación actual. Por ejemplo, si localiza el cabezal de
perforación ligeramente a la derecha de la trayectoria de la perforación prevista, puede introducir esta
distancia como una desviación a la derecha. Use el teclado en pantalla para introducir un valor, seleccione

la flecha a la Izquierda oDerecha y después Aceptar.

La desviación también tiene una opción enBlank (Blanco) para aquellas varillas donde las localizaciones
son cuestionables o no están disponibles.
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1. Acera
2. Desplazamiento derecho
3. Desviación derecha
4. Hidrante contra incendio
5. Distancia del alfiler a la

derecha
6. Configurar alfiler marcando el

hidrante contra incendio
7. Trayectoria de perforación

prevista
8. Trayectoria real de perforación
9. Configurar bandera marcando

el cruce de líneas de gas
10. Línea de gas marcada

Desplazamiento izquierdo / derecho, desviación, banderas, y
alfileres

Cierre o pausa de un trabajo
Mantenga un registro manuscrito de la profundidad, descripción, número de varilla y / o distancia desde la
entrada para cada elemento y agregue esta información a los datos de perforación, más adelante, en el
software LWD en su computadora.

Trabajos DataLog deben ser cerrados antes de que puedan ser cargados. Cierre un trabajo después de
grabar el último punto de datos.

También puede poner en pausa un trabajo por lo que permanece abierto mientras navega en las opciones del
menú. Todos los trabajos se cierran automáticamente cuando el localizador es apagado.

1. En la pantalla Locate (Localizar), conmute hacia abajo para abrir el menú "Cerrar / Pausar
grabación DataLog".

2. SeleccioneCerrar trabajo para cerrar el trabajo. El trabajo ahora se puede cargar a una
computadora (ver Carga de datos Falcon F5 a una computadora en la página 25) o agregarlo más
tarde (ver Anexión a un trabajo existente en la página 20). Se debe cerrar un trabajo abierto antes de
abrir uno nuevo.

- O -

Seleccione Pausar trabajo paramantener el trabajo abierto. Cuando regrese a la pantalla
Locate (Localizar), el siguiente punto de datos grabará en el mismo trabajo.
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1. Cerrar el trabajo
2. Pausar el trabajo

Menú Cerrar / Pausar grabación DataLog

Un localizador FF5 puede almacenar un total de 50 trabajos DataLog. El localizador muestra
una advertencia a los 45 trabajos guardados. Tratar de guardar más de 50 trabajos, regresará al
menú "Iniciar grabación" donde usted puede anexar a un trabajo o salir.
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Anexión a un trabajo existente
UseAnexar en el menú "Iniciar grabación" para agregar datos a un trabajo DataLog que haya sido cerrado o
esté en pausa.

1. En la pantalla Locate (Localizar) mantenga el gatillo apretado y conmute a la derecha una vez para
ver las Opciones de grabación.

2. SeleccioneAnexar .

1. Anexión a un trabajo existente

Menú de grabación DataLog

3. Seleccione el número de trabajo para anexar. El localizador avanza a la pantalla Locate (Localizar).

Listas de trabajos DataLog de muestra

4. Continuar la grabación de las varillas o varillas parciales tal como se describió anteriormente en
esta sección. Se recuperará la siguiente varilla apropiada en secuencia.

Visualización y extracción (Eliminación) de varillas del
localizador
La visualización de los datos de las varillas anteriores es útil cuando se requiere un retroceso y reorientación
de la trayectoria de la perforación.

1. En la pantalla Locate (Localizar) mantenga el gatillo apretado y conmute a la derecha una vez para
ver las Opciones de grabación.
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2. Conmute hacia abajo y seleccioneVer / eliminar datos de varillas .

1. Visualizar / eliminar datos de
varillas (extraer una varilla)

Menú de opciones de grabación DataLog

3. En la lista "Ver datos de varillas", se resaltan los datos de la varilla más reciente (la única que se
puede eliminar) en la fila superior.

l Para regresar a la pantalla Locate (Localizar) sin eliminar esta varilla (punto de datos), simplemente
conmute a la izquierda o a la derecha.

l Para extraer la varilla (eliminarla), haga clic para seleccionarla, luego seleccione para
confirmar.

1. Datos para la varilla más
reciente

2. Punto de medición (aparece en
blanco a menos que el valor
sea introducido en la opción
del menú Punto de medición)

Lista de varillas DataLog

La profundidad relativa estará en blanco y permanecerá así, si más de dos varillas en una fila no tienen
inclinación.

Para información adicional sobre puntos demedición, vea Adición de un punto demedición a DataLog
de perforación en la página 23.

Las profundidades en verde se grabaron en la LL; Las profundidades en blanco se grabaron en un punto
de localización (LP).

La profundidad relativa (Prof. Rel.) es un cálculo de qué tan profundo está el cabezal de perforación por
debajo de la elevación del equipo de perforación o "línea de referencia de elevación cero" (vea el
diagrama en la siguiente sección). Se basa en la longitud de la varilla y la inclinación promedio



DIGITAL  CONTROL  INCORPORATED

22 Manual delOperador LWD 3.04 DigiTrak

acumulada por la varilla. La profundidad relativa puede ser negativa o positiva. Grabar una varilla sin
inclinación (varilla en blanco) resultará en un valor de profundidad relativa en blanco.

Una profundidad relativa en blanco (---) se produce cuando se utilizan opciones de grabación en blanco
o inclinación solamente.

4. Haga clic en para eliminar el punto de datos de la última varilla, o enSalir para cancelar
y regresar a la pantalla Locate (Localizar).

5. Siga estos pasos para cada varilla que necesite eliminar, seleccionar el punto de datos más
reciente de la lista que semuestra en el paso 3 y para eliminar. Cuando haya terminado de
eliminar las varillas, conmute a la izquierda o a la derecha en la lista Ver datos de varillas para
regresar a la pantalla Locate (Localizar). Asegúrese de que el número de varillas eliminadas
coincide con el número de varillas extraídas.

Medición y documentación de la última varilla
Cuando el cabezal de perforación sale del suelo o alcanza la posición final deseada en el pozo, mida y
documente la longitud de la última varilla. Ésta será la longitud del tubomenos la longitud de la varilla de
perforación que queda en el carro de la perforadora. Por ejemplo, si la longitud de la tubería es de 3m y
quedan 2m desde las abrazaderas de enganche / desenganche a la parte superior de la varilla, la medición
de la última varilla será de 3 – 2 = 1m.

La últimamedición de varilla se puede introducir manualmentemás adelante en el software LWD, después
de cargar el trabajo. O bien, ingrésela ahora para registrar la longitud aproximada como parcial. Por ejemplo:

1. En la pantalla Locate (Localizar) mantenga el gatillo apretado y conmute a la derecha una vez para
ver las Opciones de grabación.

2. Conmute hacia abajo y seleccioneGrabar una varilla parcial .

Medición de la última varilla
1. Perforadora
2. Parte superior de la varilla
3. 2 m longitud de la varilla que

permanece en el carro de perforadora
4. Abrazaderas
5. Distancia X (desde la varilla 0 hasta la

última varilla)
6. Superficie de terreno (topografía)

7. Línea de referencia de elevación cero
8. Cabezal de perforación en el punto de salida (última

varilla)
9. Longitud de la tubería 3 m
10. Profundidad
11. Profundidad relativa (Prof. rel.)

Si la longitud de la última varilla es de 1.2m, grabe unamitad de varilla de (1.5m), que es aproximadamente
lo mismo. Esto elimina tener que introducir el valor manualmentemás adelante en LWD.
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Adición de un punto de medición a DataLog de perforación
Use un punto demedición opcional para anotar una diferencia en elevación entre la entrada y la salida de la
perforación, lo que proporciona una gráficamás precisa de la perforación y del terreno en el software LWD.

Desde el menúPrincipal, seleccioneDataLog de perforación, después Agregar punto de medición. El
punto demedición también se puede introducir más adelante en el software Log-While-Drilling, después de la
carga de datos (ver Cambio de elevación del punto demedición en la página 32).

1. En el menú deDataLog , seleccioneAgregar punto de medición .

2. De la lista de trabajos de perforación existentes mostrada, seleccione el trabajo al que va a añadir
el punto demedición.

3. Seleccione el icono del teclado.

1. Configurar el punto de
medición de vuelta a
desconocido (vea profundidad
relativa en la página 21)

2. Seleccionar el teclado para
introducir la diferencia de
elevación conocida

Menú de punto de medición

4. Use el teclado en pantalla para introducir el valor medido por la diferencia de elevación entre la
entrada y la salida de la perforación.

Este teclado incluye un botón "+/-", ya que la diferencia de elevación puede ser positiva o negativa. El
teclado supone que el valor será positivo, es decir, que la salida tiene una elevaciónmás alta que la
entrada. Utilice el botón +/- para cambiar, según sea necesario.

5. SeleccioneAceptar para fijar el valor que semuestra como el valor del punto demedición. La
pantalla regresa al menú DataLog.

Más tarde, un punto demedición se puede agregar al trabajo, en el software Log-While-Drilling
(ver el enlace anterior). La configuración de un punto demedición de 0m hará que los puntos de
entrada y salida estén a lamisma elevación. Si no se ingresa el punto demedición, el valor
predeterminado es "---", (en blanco), no 0m.

Eliminación de un trabajo DataLog

1. En el menú de DataLog , desplácese hacia abajo y seleccioneDelete DataLog job
(Eliminar trabajo DataLog).

2. Seleccione el botón para eliminar uno o todos los trabajos.

3. Si va a eliminar un trabajo, seleccione de la lista de trabajos DataLog disponibles.
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4. En la pantalla de confirmación, seleccioneConfirmar para eliminar oSalir para
cancelar.

Un trabajo eliminado del localizador no puede ser recuperado. Asegúrese de que ha cargado los trabajos que
desea guardar a una computadora, antes de eliminarlos del localizador.
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Log-While-Drilling 3.04 (Registro-al-Perforar)

Instalación de los controladores para Bluetooth y Software
LWD

Antes de eliminar una versión anterior de LWD, lea la sección de Compatibilidad en la página 1
para obtener más información.

Los requisitos mínimos del sistema para el uso del software LWD en una computadora se pueden encontrar
bajo Software LWD en la página 4.

La ubicación predeterminada de los archivos del programa de LWD es c:\Program Files (x86)\DCI\DigiTrak
LWD 3.04. La ubicación predeterminada de los archivos demuestra y trabajos DataLog es My
Documents/DCI. Usted puede cambiar estas dos ubicaciones predeterminadas durante la instalación o
cuando guarde un trabajo cargado.

1. Cierre todas las aplicaciones abiertas.

2. Inserte la unidad flash LWD 3.04 en un puerto USB y vea el contenido de la unidad.

3. Abra el archivo readme (léame) y siga las instrucciones detalladas.

4. Abra la carpeta LWD Kit y haga doble clic enDrivers for LWD(Controladores para LWD) para
instalar los controladores.

5. Conecte el radio USB para Bluetooth a un puerto USB de su computadora. Si la computadora está
conectada a Internet, los controladores pueden instalarse automáticamente. Si no sucede esto,
abra la carpeta del controlador de Bluetooth en la unidad flash USB y haga doble clic en el archivo
*.exe para instalar los controladores (si no ve las extensiones de archivo como .exe, haga doble
clic en el archivo tipoApplication (Aplicación)).

6. Abra la carpeta DigiTrak LWD Software y haga doble clic en el archivo configuración (setup.exe)
para instalar el software LWD.

Después de que se haya instalado el software LWD 3.04, aparecerá un icono de acceso directo
en su escritorio.

Carga de datos Falcon F5 a una computadora
Al cargar los trabajos DataLog desde el localizador Falcon F5 a su computadora implica agregar el número
de identificación del localizador F5 y la dirección de Bluetooth a la lista de dispositivos Bluetooth del
software LWD y luego cargar los archivos a la computadora a través de la conexión Bluetooth.

Añadir el localizador Falcon F5 a la lista de dispositivos Bluetooth LWD
Un localizador Falcon F5 debe añadirse a la lista de dispositivos Bluetooth en el software LWD antes del
primer uso.

1. Encienda su computadora e inserte el adaptador USB para Bluetooth a un puerto USB.

2. Encienda el localizador Falcon F5 y seleccioneSystem Information (Información del sistema) en
el menú principal.
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3. El número de serie (ID) del Falcon F5 está en la página uno y la dirección de Bluetooth (BT) está en
la página 2. Mantenga esta pantalla abierta, o anote estos números.

4. Abra LWD 3.04 haciendo doble clic en el icono en su escritorio.

5. Haga clic enBluetooth (menús View > Bluetooth Device List (Ver > Lista de dispositivos
Bluetooth)) para abrir la casilla de diálogo Bluetooth Device List (Lista de dispositivos Bluetooth).

1. Dirección del dispositivo
Bluetooth

2. Nombre del dispositivo
Bluetooth

Casilla de diálogo Bluetooth Device List
(Lista de dispositivos Bluetooth)

6. Escriba suBluetooth Device Address (Dirección del dispositivo Bluetooth) en el campo
especificado.

7. En el campoBluetooth Device Name (Nombre del dispositivo Bluetooth) introduzca el número de
identificación o el nombre de su localizador como lo desee. Esto es importante si usted tiene
múltiples localizadores.

8. Haga clic enAdd (Agregar).

9. Haga clic enOK. El dispositivo aparece en la lista de dispositivos Bluetooth.

Ahora está listo para cargar los datos del trabajo.

Carga de DataLog o Línea Blanca desde un Localizador

Nota iGPS

Debido a que un trabajo de Línea Blanca suele estar asociado con un trabajo DataLog
específico, cargue un trabajo DataLog primero para poder abrirlo y luego importar las Líneas
Blancas asociadas.

Si todavía no se ha efectuado la perforación, usted puede importar una Línea Blanca en un
trabajo LWD en blanco (nuevo). Pero no lo elimine del localizador, porque después de que se
haya cargado el trabajo DataLog de la perforación, la Línea Blanca sólo se puede agregar al
trabajo importándola directamente desde el localizador.



DIGITAL  CONTROL  INCORPORATED

Manual delOperador LWD 3.04 DigiTrak 27

1. Desde el menú principal, abra el menúDataLog o el menú Trazo de Líneas Blancas .
Este proceso debe repetirse por separado para cada uno de estos elementos.

2. SeleccioneCargar .

3. Seleccione el trabajo a cargar. "Waiting for PC connection…" (En espera de la conexión con su
PC) semuestra en la parte inferior de la pantalla.

Si los datos no son comunicados en dos minutos, el localizador vuelve al menú DataLog. Los
datos deben ser comunicados a la computadora dentro de un lapso de 15minutos o el
localizador se apagará debido a la inactividad.

4. En LWD, haga clic enNuevo (menús File > New (Archivo > Nuevo)).

5. Seleccione DataLog o Línea Blanca:

l Para un trabajo DataLog, haga clic enCargar los datos (menús File > Upload Control
(Archivo > Control de carga).

l Para una Línea Blanca, haga clic enManejo de Líneas Blancas GPS (menús Edit >
GPS White Lines (Editar > Líneas Blancas GPS), después en Import (Importar).

1. Conexión
2. Nombre del localizador
3. Conectar al dispositivo

Casilla de diálogo Control de carga, DataLog o
Línea Blanca

6. En la casilla de diálogo Upload Control (Control de carga), seleccioneBluegiga Bluetooth Low
Energy.

7. Seleccione el nombre de su localizador de la lista desplegable Bluetooth.

8. Haga clic enConnect to Device (Conectar a dispositivo) para comenzar a cargar. Un icono en la
pantalla del localizador muestra que los datos se están cargando; un archivo de datos de gran
tamaño puede tardar hasta unminuto en transferirse.

El Bluetooth de baja energía requiere que el dispositivo transmisor (Falcon F5) y el dispositivo
localizador (Radio USB para Bluetooth) se encuentren dentro una distancia de 0.5m el uno del
otro.
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9. Después de la transferencia de archivos:

l Después de transferir un DataLog, aparece la casilla de diálogo de Información del trabajo
DataLog. Usted puede ingresar los datos solicitados ahora omás tarde.

l Después de transferir una Línea Blanca, aparece en el diálogo de Líneas Blancas GPS .

9. Haga clic enOK.

Los datos del trabajo nuevo semuestran en los campos de información y en las áreas de las gráficas, en la
ventana de la aplicación LWD.

Si ha creado un nuevo trabajo LWD sólo para importar una omás Líneas Blancas, es un buenmomento para
guardarlo, aunque aparezca en blanco. O bien, exporte el archivo KML, que lo guarda para verlo más tarde en
Google Earth y descarte el trabajo LWD.

Las Líneas Blancas sólo son visibles cuando el trabajo se exporta al formato KML (ver
página 44) y es visto enGoogle Earth. Las Líneas Blancas no son visibles en LWD.

Recomendaciones para cargar
DCI recomienda que una vez que esté viendo sus datos en LWD, "guarde como" el archivo con una
convención de nomenclatura, como un sufijo "-orig" o similar. Deje este archivo como su original no editado.
Inmediatamente "guardar como" el archivo de nuevo con su convención de nomenclatura común, sin el sufijo
"-orig" y utilice este como su archivo de trabajo. Esto asegura que no importa cuántos cambios realice en el
archivo en LWD, todavía tendrá una copia original de seguridad para consultar.

Si ha grabado un punto de datos mediante la opción de sólo inclinación o de varilla en blanco, estos puntos
de datos aparecerán como faltantes en la gráfica. El software LWD hará suposiciones para llenar los datos
faltantes o usted puede introducir manualmente sus propios datos (vea Edición de los puntos de datos en la
página 36).



DIGITAL  CONTROL  INCORPORATED

Manual delOperador LWD 3.04 DigiTrak 29

Apertura de archivos
Inicie el programa Log-While-Drilling (LWD™) 3.04 haciendo doble clic en el icono de LWD en el
escritorio.

Una tabla nueva de datos LWD estará en blanco; un archivo LWD con los datos, se verá así:

DataLog con presión del fluido en LWD 3.04
1. Barra de menús
2. Barra de herramientas
3. Tabla de datos
4. Información del sitio

5. Información del trabajo
6. Banderas y alfileres
7. Perfil altimétrico de

perforación
8. Topología

9. Perfil de inclinación
10. Gráfica de presión de

perforación
11. Barra de estado

Para cargar un trabajo de su localizador, vea Carga de datos Falcon F5 a una computadora en la página 25.

Haga clic enAbrir (menús File > Open (Archivo > Abrir)) para abrir un archivo DataLog existente.
También puede abrir un archivo DataLog directamente desde el Windows Explorer haciendo doble clic en un
archivo DataLog lwd o dl5 anterior. Vea Compatibilidad en la página 1 para obtener más información.

Información detallada sobre el uso y la edición de los campos de datos se proporciona en los archivos

Ayuda . O haga clic enAyudante de descripción emergente , después haga clic en un elemento
de la pantalla para obtener ayuda con esa función.

Muchos de los comandos demenú LWD son similares a los utilizados en otros programas deWindows, y
algunos tienen iconos asociados en la barra de herramientas. Ponga el cursor sobre cualquier icono en LWD
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para una descripción emergente que describe su función. Los iconos o elementos demenú que aparecen en
gris no pertenecen al archivo DataLog actual. Ver el Apéndice B en la página 50 para obtener una lista
completa de las opciones del menú y sus correspondientes botones de la barra demenús.

La pantalla LWD 3.04
Información del sitio

Haga clic en Información del sitio , o en los menús seleccioneEdit > Site Information (Editar >
Información del sitio), o haga doble clic en el área de información del sitio mostrada abajo, para editar esta
información.

Casilla de diálogo Site Information (Información del sitio)

Toda la información de dirección y de contacto para el trabajo, cliente y contratista se enumeran en el
informe impreso (ver Cómo guardar, imprimir y enviar su trabajo LWD en la página 45 paramás información).
Los números de teléfono se excluyen de los informes impresos.

La información del sitio permanece de trabajo a trabajo para reducir la necesidad de volver a
ingresar los mismos datos. Si esta información no se guarda de trabajo a trabajo, en especial
para las versiones posteriores aWindows XP®, intente esto: salga de LWD, haga clic con el
botón derecho en el icono LWD del escritorio, seleccioneProperties (Propiedades),
seleccione la pestañaCompatibility (Compatibilidad), marque la casilla "Run this program as
an administrator" (Haga funcionar este programa como un administrador), y haga clic enOK.
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Información del trabajo

Haga clic en Información del trabajo , en los menús seleccioneEdit > Job Information (Editar >
Información del trabajo), o haga doble clic en el área de información del trabajo, para editar esta información.

Casilla de diálogo Job Information (Información del trabajo)

La sección de Información del trabajo muestra la información estadística relacionada con el trabajo. Algunos
campos no se pueden editar.

Información de la longitud de la varilla

Default Rod Length (Longitud predeterminada de la varilla) Los datos de longitud de la
varilla se incluyen en las cargas, pero se pueden cambiar aquí si se ha
ingresado de forma incorrecta en el localizador.

First Rod Length (Longitud de la primera varilla) Esta es la longitud de la varilla para el
primer punto de datos (varilla 0), que normalmente es una varilla
parcial. Este valor se determinamediante la medición de la cantidad de
varilla de perforación que permanece en el carro de la perforadora
desde la abrazadera hasta la parte superior de la varilla, cuando la
varilla 0 se graba. Vea el paso 4 en la página 8.

Last Rod Length (Longitud de la última varilla) Esta es la longitud de la varilla para el
último punto de datos, la cual, normalmente, es una varilla parcial.
Este valor se determinamediante la medición de la longitud de la varilla
de perforación que permanece en el carro de la perforadora, desde la
abrazadera hasta la parte superior de la varilla y luego sustrayendo
esta distancia de la longitud de la varilla. Por ejemplo, si la longitud de
la varilla que permanece en el carro es de 1.8m, y la longitud de su
varilla es de 3.0m, la última varilla medirá 1.2m(3.0m – 1.8m). Ver
Medición y documentación de la última varilla en la página 22.
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Información del localizador

Serial Number (Número de serie) El número de serie El número de serie (de
identificación) del localizador.

Date Format (Formato de fecha) Esto corresponde al primer punto de datos cargado.

Job ID (Identificación del trabajo) El número asignado al trabajo en el
localizador.

Data Points (Puntos de datos) Número de puntos de datos recogidos (incluye datos
insertados manualmente).

Cambio de elevación del punto de medición

Do Not Use Reference
Elevation

(No use la elevación de referencia) Normalmente, deje esta casilla
marcada. Desactivar esta casilla para introducir una elevación de
referencia en el campo debajo de ella.

Reference Elevation (Elevación de referencia) Esta es la elevación verdadera del eje X
sobre el nivel del mar. Este valor no se utiliza en los cálculos; sólo se
indica en el reporte de Información del trabajo y en el título de la
gráfica.

Relative Elevation at Entry (Elevación relativa a la entrada) La distancia vertical desde la línea de
referencia de elevación cero hasta el cabezal de perforación, cuando
no se puede colocar en la línea de elevación cero.

Do Not Use Exit Survey Point (No use punto demedición de salida) Seleccionada en forma
predeterminada, esta casilla causa que la elevación de salida sea
calculada sólo en base a los datos de inclinación, varilla y profundidad.

Relative Elevation at Exit (Elevación relativa a la salida) La diferencia positiva o negativa entre
las elevaciones de la entrada y de la salida. Introduzca un valor
negativo si la salida estámás baja que el punto de entrada; no use un
símbolo + para un valor positivo. Esta información puede ser capturada
en el localizador al establecer un punto demedición (ver la página 23).

Información general

Name (Nombre) Introduzca un nombre de trabajo opcional.

Work Order # (Orden de trabajo #) Introduzca un número de orden de trabajo
opcional.

Comments (Comentarios) Introduzca comentarios del trabajo opcional.

Entry (GPS) (Entrada (GPS)) Las coordenadas GNSS de la entrada (provienen del
LWD Mobile).

Exit (GPS) (Salida (GPS)) Las coordenadas GNSS de la salida (provienen del
LWD Mobile).

Contabilidad para la profundidad del pozo de entrada
Si el cabezal de perforación comienza en un pozo de entrada, ingrese la profundidad del cabezal de
perforación en el pozo en la Rel. Elev. At Entry (Elev. Rel. a la entrada) de la pantalla Job Information
(Información del trabajo).
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Tabla de datos
La tabla de puntos de datos muestra todos los puntos de datos en el trabajo, en orden secuencial, junto con
sus datos asociados. Las unidades de profundidad y de inclinación semuestran en la casilla de información
del trabajo. En esta tabla usted puede insertar, editar, eliminar, ocultar o sacar puntos de datos individuales.

Tabla de datos

Este diagrama en la página 22muestra donde ocurre cada una de estas mediciones de datos, en una
trayectoria de perforación.
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Rod ID (Identificación de varilla) Número de la varilla y estado del punto de
datos. Semuestra una bandera de color para indicar el estado de los
datos:

l Bandera roja: Inclinación faltante; ingresar la inclinación para que
la trayectoria de la perforación sea calculada correctamente.

l Bandera magenta: Profundidad faltante; solamente pone de
relieve los puntos de datos de la inclinación para el operador. Abra
la casilla de diálogo Edit Data Point (Editar punto de datos) y haga
clic en OK para restaurar esta bandera ya sea azul o verde en
función de los datos introducidos por el operador para la
profundidad.

l Bandera azul: Los puntos de datos han sido editados
l Bandera gris: Los datos ha sido ocultados o sacados
l Bandera verde: Datos sobrescritos
l Bandera negra: Datos originales

Rod Len. (Long. de varilla) La longitud de la varilla.

Bore Len. (Long. de la perforación) La longitud de la perforación (suma de todas
las longitudes de varillas anteriores, más la longitud de la varilla
actual).

X Dist. (Distancia X) Distancia horizontal desde la entrada.

Pitch (Inclinación) El valor de la inclinación grabado en el punto de datos
especificado.

Rel. Depth (Profundidad relativa) La profundidad del cabezal de perforación por
debajo de la línea de elevación cero.

Depth (Profundidad) La distancia del cabezal de perforación a la superficie del
terreno. Esta puede ser medida, introducidamanualmente por el
usuario, o interpolada por el software LWD, basada en los datos
insertados o faltantes.

Rel. Elev. (Elevación relativa) La diferencia positiva o negativa desde la línea de
elevación cero.

L/R Offset (Desplazamiento izquierdo / derecho) La distancia horizontal se
mantiene a la izquierda (L) o a la derecha (R) de una característica
junto a la trayectoria de la perforación, tal como una guarnición,
barandilla o trayectoria determinada.

Deviation (Desviación) Hasta qué punto el cabezal de perforación se desvió de la
trayectoria de perforación prevista.

Date/Time (Fecha / hora) La fecha y hora en que los puntos de datos
especificados fueron grabados. Esta información no aparecerá en el
informe impreso. La fecha / hora debe ser configurada correctamente
en el localizador, para que esta información sea precisa.
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Type (Tipo) Información relativa al tipo de datos grabados en el punto de
datos:

l BL: Blank (En blanco) (Sin inclinación, profundidad o datos GNSS)
l PO: Pitch Only (Inclinación solamente) (sin datos GNSS)
l LL: Locate Line (Línea de localización)
l FLP: Front Locate Point (Punto de localización frontal) los datos
GNSS se ocultan automáticamente; haga clic con el botón derecho
paramostrarlos. GNSS X Distance) (Distancia X) (ver la página 22)
se posicionarámás allá del cabezal de perforación.

l IN: Inserted data point (Punto de datos insertado). Los valores
predeterminados de inclinación y de profundidad son interpolados a
partir de los datos adyacentes y no semuestran de forma
predeterminada. Estos datos se puedenmodificar a voluntad al
sobrescribir los valores predeterminados de la lista. El nuevo punto
de datos aparece alfabéticamente (tales como, el primer punto
insertadomanualmente después de la varilla número 2 aparece
como 2-A, el segundo como 2-B, etc.).

RawDepth La lectura de profundidad en el localizador en el FLP (profundidad
proyectada) o LL (profundidad). Sin procesar significa "sin
correcciones aplicadas".

RawDist Una cantidad de corrección. Agregado a la Distancia X, este valor se
produce en donde la LL o el FLP están en relación con el gráfico del
cabezal de perforación para la varilla. La distancia horizontal desde
donde un punto de datos fue tomado, hasta un punto directamente
encima del transmisor. Sin procesar significa "sin correcciones
aplicadas".

Avg. Pres. (Average Pressure (Presión promedio)) Ver Puntos de datos de presión
de perforación en la página 39.

High Pres. (High Pressure (Alta presión)) Ver Puntos de datos de presión de
perforación en la página 39.

Max Pres. (Maximum Pressure (Presiónmáxima)) Ver Puntos de datos de
presión de perforación en la página 39.

Latitude (Latitud) La lectura de latitud proporcionada por el módulo iGPS
opcional.

Longitude (Longitud) La lectura de longitud proporcionada por el módulo opcional
iGPS.

GNSS X Dist. (GNSS X Distance (Distancia X GNSS)) (ver la página 22) X Distance
plus RawDist.

Comment (Comentario) Cualquier comentario sobre los puntos de datos
individuales se puede agregar paramostrarse en esta columna (ver
Editar varilla / punto de datos abajo).
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Nota iGPS

Con el módulo iGPS, la lat / long se incluye para los puntos de datos tomados en la línea de
localización (LL). Lat / long estará en blanco para los puntos de datos tomados en el FLP o
grabados como inclinación solamente, o en blanco. Los datos lat / long que están en blanco
debido a que se graban en el FLP pueden hacerse visibles haciendo clic con el botón derecho del
ratón en la fila de datos y seleccionando Unhide GNSS (Mostrar GNSS). De la misma manera,
haga clic con el botón derecho en una fila para ocultar datos lat / long si lo desea.

Sin el módulo iGPS, los datos de latitud y longitud (lat / long) siempre serán "n/a" (no
disponible).

Los símbolos en la lista de puntos de datos identifican diferentes tipos de datos:

o (overwritten) datos sobrescritos manualmente

e (edited) longitud de la varilla editada

i (interpolated) datos interpolados

f (filled in) datos rellenados; los datos faltantes en la carga original

h (hidden) datos ocultados

x datos de inclinación faltantes

Edición de los puntos de datos
Haga clic con el botón derecho en un punto de datos en la tabla para abrir unmenú desplegable con las
opciones para editar, insertar, eliminar, ocultar / mostrar, ocultar / mostrar GNSS y retirar.

Menú del atajo para la tabla de punto de datos

Editar varilla / punto de datos

Haga clic con el botón derecho en el punto de datos y seleccioneEdit (Editar), o simplemente haga doble
clic en un punto de datos en la lista o en la gráfica. Edite los datos o añada comentarios, según sea
necesario. Haga clic enOK para guardar los cambios oCancel (Cancelar).
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1. Longitud de la varilla en la
mismas unidades que la
medición de profundidad

2. La casilla se marca
automáticamente si la varilla en
blanco es grabada o insertada.

3. La casilla se marca
automáticamente si es
insertada la varilla en blanco o
para inclinación solamente

Casilla de diálogo Edit Data Point (Editar
punto de datos)

Si existe un punto de datos en blanco, la casilla de verificaciónPitch is Missing/Unknown (Inclinación
faltante / desconocida) es seleccionada predeterminadamente. Si usted no introduce el valor correcto de la
inclinación y desmarca la casilla, habrá un vacío 'en la línea del perfil de inclinación en la gráfica. El punto de
datos faltante se hará resaltar en la gráfica. Ver Resolución de datos faltantes en la página 13.

Si se inserta una varilla nueva o un punto de datos en blanco o de inclinación solamente es grabado, la
casilla de verificaciónDepth is Hidden/Unknown (Profundidad ocultada / desconocida) es seleccionada
predeterminadamente. Si no se introduce el valor de la profundidad y se desmarca la casilla, habrá un vacío
en la línea de topología en la gráfica y el punto faltante no serámostrado.

Para recuperar los datos originales grabados, haga clic en el botónRestore Default (Recuperar
predeterminados) junto a los datos que se van a recuperar.

Insertar varilla / punto de datos

Haga clic con el botón derecho en el punto de datos antes de donde el nuevo punto de datos se vaya a
insertar y seleccione Insert (Insertar). Un nuevo punto de datos aparece en la lista de datos y en la gráfica.

El nuevo punto de datos será numerado igual que el anterior, con una letra adjunta. Por ejemplo, el primer
punto insertadomanualmente después de varilla 2 aparecerá como 2-A, el segundo como 2-B, y así
sucesivamente. Los valores indicados para la inclinación y la profundidad son interpolados a partir de los
datos adyacentes y la profundidad se oculta de forma predeterminada. El tipo de varilla semostrará como
IN, para datos insertados. Usted puede cambiar los valores de los datos como sea necesario. Para
recuperar los valores de los datos interpolados originales, haga clic enRestore Default (Recuperar
predeterminados) según el campo de datos correspondiente.

Elimine varilla insertada / punto de datos

Haga clic con el botón derecho en la fila de datos que desee eliminar y seleccioneDelete (Eliminar). El punto
de datos se saca de la lista de puntos de datos y de la gráfica.
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Los datos originales no se pueden eliminar. Si una varilla se graba dos veces involuntariamente, seleccione
Remove (Sacar) para sacar ese punto de datos.

Hide (Ocultar)

Cuando se selecciona esta opción, el punto de datos sigue apareciendo en la lista de datos pero no se podrá
ver en la gráfica. Los datos, sin embargo, se incluyen en los cálculos. Unamarca de verificación se coloca
junto a la opción en el menú emergente y estará visible la próxima vez que se edite esta varilla.

Remove (Sacar)

Seleccione esta opción para sacar el punto de datos de la lista, gráfica y de los cálculos. Utilice esta opción
en los datos originales que fueron grabados dos veces, en forma involuntaria.

Perfil altimétrico de los datos de perforación y gráfica de
presión de perforación
El Perfil altimétrico de los datos de perforación ofrece una representación gráfica de los datos
contenidos en la tabla. Los puntos de datos del perfil ocultos o sacados no semostrarán en el área de la
gráfica. El perfil altimétricomostrará los puntos si están ocultos, pero no los mostrará si son sacados. Los
datos residen en su propia gráfica deDrill Pressure (Presión de perforación) en la parte inferior de la
ventana de LWD, separada de los datos del perfil de perforación pero con cada punto de datos alineado con
la varilla, para correlacionar con el perfil de perforación.

Ponga el cursor sobre cualquier punto de datos gráfico, bandera o alfiler, paramostrar detalles. Haga doble
clic en los puntos de datos o en una fila de la tabla de datos para ver y / o editar los datos. Haga clic en
cualquier parte de la gráfica para que la tabla muestre los datos de esa parte de la gráfica.

Puntos de datos Puntos de datos que no se han ocultado o eliminado.

Valores Valor de los puntos contenidos en el área de la gráfica.

Coordenadas del cursor Coloque el cursor en cualquier parte del área de la gráfica para ver el
valor de las coordenadas en ese punto. Coloque el cursor en un punto
de datos paramostrar los valores de los datos grabados en ese punto.

Acercamiento / Alejamiento Oprima la tecla de Control y arrastre el puntero a través de un área para
acercarla. Para regresar a la escala normal, oprima Control y haga clic
en cualquier parte del área de la gráfica.

Banderas y alfileres Ubicado en la parte superior de la gráfica.

Puntos de datos del perfil altimétrico de perforación

Perfil altimétrico de perforación
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Verde El perfil topográfico calculado de la perforación. Estos puntos sólo
pueden ser editados para la profundidad, después de lo cual también
aparecerán resaltados.

Azul La perforación calculada en base a las lecturas de la longitud y la
inclinación de la varilla.

Resaltado Los puntos con un círculo verde detrás de ellos indican que las varillas
se han eliminado durante el proceso de recolección de datos.

Puntos de datos de presión de perforación

Gráfica de presión de perforación

Max Pres. (Presiónmáxima) La presiónmáxima recogida durante el trabajo hasta
cuando el punto de datos fue grabado incluyendo las varillas
eliminadas.

High Pres. (Presión alta) La presión alta grabada durante el trabajo, hasta cuando
el punto de datos fue grabado incluyendo las varillas eliminadas. Este
es el promediomás una desviación estándar— esto incluye el 84% de
las lecturas de la presión (suponiendo una distribución normal).
Estadísticamente, habrán sido picos ocasionales por encima de esta
presión.

Avg. Pres. (Presión promedio) La presión promedio grabada durante el trabajo,
hasta cuando el punto de datos fue grabado incluyendo las varillas
eliminadas.

Los datos de la presión de perforación se recogen a razón de aproximadamente unamuestra cada cuatro
segundos. Perforar lentamente dará lugar amás puntos de datos por varilla. El número de puntos de datos
recolectados por varilla semuestra en la tabla impresa de informe de datos bajo la columna deNum
Samples (Núm de puntos de datos recogidos) (vea la tabla muestra de datos del fluido de perforación
impresa en Apéndice C en la página 58).

LWD proporciona una interacción perfecta entre el perfil altimétrico y la gráfica de presión de perforación y
los datos tabulares. Ponga el cursor sobre un punto de datos paramostrar la información detallada recogida
en ese punto. Haga clic en un punto de datos en el perfil altimétrico de perforación paramostrar su fila
correspondiente en la tabla de puntos de datos; Esto hace que sea especialmente fácil alinear un punto de
datos en una gráfica para trabajos que exceden de 50 varillas. Los espacios en los puntos de datos
cartografiados aparecerán cuando los datos falten o se eliminen (pero no cuando están ocultos). A veces es
útil ocultar un punto de datos en la gráfica permite que otros elementos seanmostrados, tal como una



DIGITAL  CONTROL  INCORPORATED

40 Manual delOperador LWD 3.04 DigiTrak

bandera de servicio público. Un punto de datos oculto en el perfil altimétrico seguirá siendomostrando en la
lista de puntos de datos.

Cada gráfica tiene su propio esquema de color para la visualización de puntos de datos.

Los datos de presión de perforación no se pueden eliminar. Si un evento de sobrepresión se grabó durante
una varilla que fue eliminada posteriormente, se fusionará con los datos de la siguiente varilla grabada. Los
datos de esa varilla entera se pueden remover.

Banderas de servicios públicos

Utilice banderas de servicios públicos paramostrar la ubicación y el tipo de servicios públicos en la gráfica y
en el informe impreso. Para agregar o editar banderas de servicios públicos, haga clic enEditar banderas

de servicios públicos (menús Edit > Utility Flags (Editar > (Banderas de servicios públicos)) para
abrir la casilla de diálogo Utility Flags (Banderas de servicios públicos). O coloque el cursor en la ubicación
deseada en la gráfica y después oprima Shift+click.

Casilla de diálogo de banderas de servicios públicos

Type (Tipo) Seleccione de la lista desplegable. La bandera aparecerá en la
gráfica como un círculo que usa los colores recomendados por la
APWA (American Public Works Association - Asociación Americana
deObras Públicas).

X Dist (Distance) (Dist X (Distancia)) La longitud horizontal sobre la superficie del suelo,
medida desde la entrada hasta el servicio público.

Depth (Profundidad) La longitud vertical desde la superficie hasta el servicio
público.

Comment (Comentario) La leyenda predeterminada es el tipo del servicio público;
introduzca un comentario para crear una nueva leyenda.

Text Slope (Inclinación del texto) El ángulo del texto de la leyenda en la gráfica.
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Edición y anotación en las gráficas
Las gráficas pueden ser editadas y anotadas en un diferente número demaneras.

Definir las propiedades de la gráfica
En el menúEdit (Editar), utilice uno de los comandos deProperties (Propiedades) para cambiar los bordes y

la escala de la gráfica. O, haga clic en la gráficaPerfil o enPresión en la barra de herramientas. Es
aconsejable configurar las gráficas de perfil y presión en los mismos bordes horizontales para que sus líneas
de datos se alineen entre sí. Para ocultar una gráfica, configure todos los bordes a cero.

Casilla de diálogo para las propiedades del
perfil altimétrico

Agregar anotaciones
UseAnnotations (Anotaciones) para definir formas y leyendas que aparezcan en las gráficas para describir
las condiciones del sitio de trabajo y otros puntos de interés

Para dibujar formas directamente en la gráfica, coloque el cursor en la ubicación deseada en la gráfica,
mantenga pulsada la tecla Shift y arrastre el ratón. Cuando usted termine, la casilla de diálogo Annotations
(Anotaciones) incluye las coordenadas de la ubicación de la casilla.

Alternativamente, haga clic en la gráficaPerfil , oPresión en la barra de herramientas (ambos en el
menúEdit (Editar)), para abrir primero la casilla de diálogo Annotations (Anotaciones) y después introduzca
manualmente las coordenadas de la ubicación. 



DIGITAL  CONTROL  INCORPORATED

42 Manual delOperador LWD 3.04 DigiTrak

1. Defina los límites de la casilla y
otras propiedades en esta
sección

2. Haga clic para agregar
3. Haga clic para guardar y salir

Casilla de diálogo de anotaciones

Haga doble clic sobre una anotación existente para cambiar sus propiedades (las leyendas no pueden ser
editadas en estamanera, solamente objetos).

Seleccione unaShape (Forma) para agregarla desde la casilla desplegable. Ajuste el Line Weight (Grosor
en la línea) y Font Height (Altura de la fuente) como sea necesario. Utilice las casillas de verificación y haga
doble clic en las elipses en la secciónDraw Shape (Dibujar forma) para escoger las propiedades y colores
de la forma.

Seleccione la casilla de verificaciónDraw Caption (Dibujar leyenda) para activar la sección "Caption"
(Leyenda). Una leyenda no requiere una forma. Las leyendas aparecen centradas predeterminadamente en
la forma. Para cambiar la ubicación u orientación de la leyenda, utilice los campos Top - Left (Parte superior
- Izquierda) y Text Slope (Inclinación del texto).

Haga clic enAdd (Agregar) para agregar la anotación en la lista, entonces oprimaOK para guardar y salir.
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Editar las banderas y los alfileres
Para editar, ocultar o comentar sobre banderas y alfileres, seleccioneEdit > Flags and Pins (Editar >

Banderas y alfileres) o haga clic en .

Casilla de diálogo Flags and Pins (Banderas y alfileres)

Para añadir o editar un comentario de bandera o alfiler, seleccione un alfiler o una bandera, introduzca o edite
texto en el campo deComment (Comentar) y haga clic enEdit comment (Editar comentario) para
guardarlo.

Para ocultar una bandera o un alfiler de un informe impreso, selecciónelo y haga clic enHide (Ocultar). El
valor de la Dist. X es ahora precedido por h. Paramostrar una bandera o un alfiler oculto, selecciónelo y haga
clic enShow (Mostrar).

Para cerrar esta ventana, haga clic enOK.

Rod ID (Id. de la varilla) El número de la varilla

Number (Número) El número de la bandera o alfiler

Type (Tipo) Bandera o alfiler

X Dist. (Dist. X) La distancia horizontal a lo largo de la perforación de la
entrada (vea el diagrama en la página 22).

Rod Rel. LR (Varilla relativa Izq / Der) La distancia de la varilla está a la izquierda o
a la derecha de la característicamarcada con un alfiler. No aplicable a
banderas.

Comment (Comentario) Comentario introducido por el usuario
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Visualización de datos GNSS en Google Earth

Cuando usted abre su DataLog en LWD 3.04, tiene la opción de ver la perforación como una superposición
del mapa deGoogle Earth. Para ver su perforación enGoogle Earth, haga lo siguiente:

1. Instale Google Earth en su computadora. Vaya a https://www.google.com/earth/.

2. En LWD 3.04, abra el trabajo deseado.

Opcional: Si aún no ha añadido una Línea Blanca existente a la perforación, consulte Carga de DataLog
o Línea Blanca desde un Localizador en la página 26 para hacerlo así y después guardarlo.

3. Seleccione File > Export to KML...(Archivo > Exporte a KML...).

4. Utilice el nombre de archivo sugerido o cree uno propio, seleccione la carpeta de destino deseada y
haga clic enSave (Guardar). Esto crea un archivo KML separado que contiene los datos GNSS
varilla por varilla y todas las Líneas Blancas importadas en este trabajo.

5. Localice el archivo kml en su computadora y haga doble clic para abrirlo enGoogle Earth.

La interfaz deGoogle Earth tiene varias opciones paramoverse por el mapa, cambiar vistas y editar las
preferencias de visualización. Para obtener más información, consulte la Ayuda de la aplicación Google
Earth.

La siguiente tabla muestra algunas funciones comunes.

Para Haga esto

Mover el mapa Arrastre el mapa

Girar el mapa Ctrl+rueda de ratón

Acercar / alejar Utilice los botones + y - en la parte derecha de la pantalla, o el control
deslizante entre ellos

Imprimir el mapa Haga clic en el icono Print (Imprimir)

Guardar el mapa Haga clic en el icono Save (Guardar)

Usar la vista de nivel de calle Arrastre el icono naranja de la persona por encima del control de zoom
a un punto en el mapa; Para salir, haga clic en el botón "Salir de la vista
de calle" en la parte superior derecha de la pantalla

Cambiar la dirección en la
vista de la calle Arrastre el mapa

Mover en la vista de la calle Haga clic en el mapa cerca del borde izquierdo o derecho

Google Earth proporciona capacidades de ediciónmínimas que permiten eliminar u ocultar un punto de
latitud / longitud, pero ocultar omostrar el punto GNSS en LWD 3.04 antes de guardar el archivo KML puede
producir mejores resultados.

https://www.google.com/earth/
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Eliminación de Líneas Blancas
Para ver la perforación enGoogle Earth sin Líneas Blancas u otros elementos, expanda el menú Places
(Lugares) situado a la izquierda de la pantalla deGoogle Earth:

Seleccione o desactive las casillas como se prefiera, paramostrar u ocultar diferentes elementos en el
mapa.

Cómo guardar, imprimir y enviar su trabajo LWD
Cómo guardar los archivos del proyecto

Para guardar su proyecto, haga clic enGuardar (menús File > Save (Archivo > Guardar)). Si el archivo
ya se ha guardado, se volverá a guardar bajo su actual nombre y ubicación del archivo. Si el archivo no se ha
guardado todavía, ponga nombre el archivo y seleccione la ubicación para guardarlo en la casilla de diálogo
Save As (Guardar como) y a continuación haga clic enSave (Guardar).

El nombre de archivo predeterminado para datos de perforación DataLog en LWD 3.04 es DrillData # .lwd,
donde # representa un número que comienza en 1 y avanza automáticamente cuando se guardan los
archivos. Los datos exportados en formato KML sólo contienen datos GNSS para ver enGoogle Earth y
tienen una extensión kml en lugar de lwd.

Para guardar un archivo abierto con un nombre o ubicación de archivo diferente, seleccione File > Save As
(Archivo > Guardar como). Cambie el nombre del archivo y la ubicación como se desee, a continuación,
haga clic enSave.

Para exportar un archivo de texto Unicode de valor separado por una coma (*.csv) para usarse en una hoja

de cálculo, haga clic enExportar hoja de cálculo (menús File > Export Spreadsheet (Archivo >
Exportar hoja de cálculo)).

DCI recomienda guardar una copia de cada trabajo como una copia de seguridad, tan pronto como la abra.
Ver Carga de datos Falcon F5 a una computadora en la página 25.

Impresión y vista previa de los archivos del proyecto

Para imprimir los datos del trabajo, haga clic en Imprimir (menús File > Print (Archivo > Imprimir)).
DCI recomienda seleccionar la orientación Landscape (Horizontal) usando el botón deProperties
(Propiedades).

Para una vista previa de las páginas que se van a imprimir, haga clic enVista previa a la impresión
(menús File > Print Preview (Archivo > Vista previa a la impresión)). En la ventana de vista previa, haga
clic enPrint (Imprimir) para llegar a la casilla diálogo de impresión oClose (Cerrar) para regresar al archivo.
Si la escala impresa aparece irregular, vea Edición y anotación en las gráficas en la página 41 para ver cómo
cambiar los bordes y escala de la gráfica.
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Para editar las propiedades de la impresión, tales como la impresora, tamaño del papel y orientación del

papel, haga clic enConfiguración de impresión (menús File > Print Setup (Archivos >
Configuración de impresión)).

La página uno del trabajo impreso contiene información del trabajo, tal como la ubicación, el cliente y la
información del contratista, junto con los datos estadísticos y comentarios del trabajo. La página dos
contiene gráficas del perfil altimétrico y de la vista de planta. Desde la página tres y más adelante, se
describen los datos demedición de la topografía y los datos de la perforación. Los puntos de datos
eliminados no semostrarán.

Cómo enviar los archivos del proyecto

Su archivo LWD 3.04 del proyecto lo puede abrir cualquier persona que también tenga el
software DigiTrak LWD 3.04. LWD 3.04 también puede abrir trabajos guardados en versiones
anteriores de LWD. Vea Compatibilidad en la página 1 para obtener más información.

Para enviar un informe a un cliente que no tiene el software LWD, instalar un controlador de impresión PDF,
a continuación, imprima a esta "impresora" para crear un informe electrónico que se puede ver en cualquier
lector de PDF.

Como una alternativa para PDF, los sistemas Microsoft Windows incluyen un "Microsoft XPS Document
Writer" en la lista de impresoras disponibles. Su cliente requerirá Microsoft Internet Explorer para leer este
formato PostScript encapsulado (XPS) sin un lector XPS. Consulte, por favor http://www.microsoft.com
para obtener información adicional sobre el uso de este formato.

Una vez que tenga su escritor PDF preferido instalado (o si usted está utilizando el escritor XPS):

1. Haga clic en Imprimir (menús File > Print (Archivo > Imprimir)).

2. Use la lista desplegable deName (Nombre) para seleccionar el escritor PDF o "Microsoft XPS
Document Writer".

1. Seleccione impresora / escritor
2. Seleccione aquí la orientación

horizontal

Casilla de diálogo para las propiedades del perfil
altimétrico

http://www.microsoft.com/
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3. Haga clic enProperties (Propiedades), seleccione la orientación Landscape (horizontal)
(recomendada) y haga clic enOK para guardar la orientación y cerrar la casilla de diálogo de
Properties (Propiedades).

4. Haga clic enOK para imprimir (generar) el archivo.

5. Seleccione la carpeta donde desea guardar el archivo e introduzca un File Name (Nombre de
archivo).

6. Haga clic enSave (Guardar).

Dependiendo de la configuración de la impresión, es posible que aparezca automáticamente el archivo PDF
generado, o puede que tenga que encontrarlo y abrirlo para verlo. A la mayoría de los usuarios les resultará
conveniente enviar el archivo PDF a su cliente como un archivo adjunto a un correo electrónico.

Ubicación de archivo
La ubicación predeterminada para la muestra y los trabajos de DataLog es /Mis Documentos/DCI
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Apéndice A: Íconos DataLog del localizador

Símbolo Descripción

Agregar punto de medición – Graba un valor medido para la diferencia en elevación (elevación
de referencia) entre el inicio y el final de la perforación. Este valor ayudará a proporcionar un
perfil altimétrico más precisa en el software de LWD. Página 23

Adjuntar a un trabajo existente – Continúa agregando datos a un trabajo DataLog existente.
Seleccione el número de trabajo de la lista. Página 20

Cerrar trabajo – Guarda y cierra un trabajo DataLog. Un trabajo puede ser visto, anexado y
cargado hasta que sea eliminado de la lista de trabajos. Página 18

Confirmar eliminación – Aparece después de una solicitud para eliminar trabajos, para confirmar
la eliminación. Seleccionar para confirmar la eliminación o seleccione Salir para cancelar la
eliminación. Página 23

Crear un trabajo nuevo – Inicia un nuevo trabajo DataLog. Le pedirá que configure el trabajo con
longitudes de varilla. Página 9

Eliminar todos los trabajos – Elimina todos los trabajos almacenados en el localizador. Página 23

Eliminar trabajo – Elimina el trabajo o los trabajos DataLog seleccionados desde el localizador.
También utilizado en el menú "Eliminar trabajo" para seleccionar un trabajo para eliminar.
Página 23

Activar / Desactivar DataLog – Cuando se muestra "Enabled, click to disable" (Activado, haga clic
para desactivar), el icono es verde, la función DataLog está activada y usted puede tener acceso
a las opciones del menú DataLog en la pantalla Locate (Localizar). Cuando se muestra
"Disabled, click to enable" (Desactivado, haga clic para activar), el icono es rojo, la función
DataLog está desactivada y no ocurrirá registro. Página 7

Pausar trabajo – Abre el menú principal del localizador, pero mantiene el trabajo abierto sin
grabar datos. Los datos se continúan grabando en el número actual de trabajo cuando vuelva a
entrar en la pantalla Locate (Localizar) sin apagar el localizador. Página 18

Grabar una varilla en blanco – Registra un punto de datos sin información de inclinación o de
profundidad; se usa cuando el localizador no puede ser posicionado dentro del alcance del
transmisor. Página 12

Grabar una varilla parcial – Registra un punto de datos después de terminar una varilla parcial.
Recomendado cuando se utilizan varillas de perforación largas durante los cambios importantes
de inclinación o para trazar con precisión pequeños cambios en la topografía. Página 13

Grabar profundidad / inclinación – Registra la información de profundidad e inclinación en un
punto de datos del punto de localización frontal (FLP) o de la línea de localización (LL). Esta
opción no está disponible en el primer punto de datos de la varilla y cuando la información de la
inclinación o de la profundidad no está disponible. Las luces verdes indican la calidad de la
señal GNSS cuando el módulo iGPS está instalado. Página12
Grabación de profundidad / inclinación con el módulo iGPS instalado – Función igual que la
anterior, pero las luces verdes indican la calidad de la señal GNSS cuando el módulo iGPS está
instalado. Estas luces coinciden con las tres luces sólidas, en la extrema derecha del módulo
iGPS. Página 12
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Símbolo Descripción

Grabar inclinación solamente – Registra sólo la información de inclinación en un punto de datos;
se utiliza cuando el localizador no se puede colocar sobre el FLP o la LL. Esta opción no estará
disponible si la información de inclinación no está disponible, en cuyo caso se debe grabar una
varilla en blanco. Página 12

Configurar una bandera – Configurar una bandera al cruzar cualquier elemento de interés a lo
largo de la trayectoria de perforación, tal como una acera, una línea de servicios públicos
marcada, o la ribera de un río. Página 16

Configurar un alfiler – Configurar para marcar la ubicación de una característica del terreno a la
izquierda o a la derecha de la perforación, tal como un hidrante contra incendio o un poste de
energía que pueda ayudar a localizar posteriormente la trayectoria de perforación. Página 16

Configurar trabajo – Configura un nuevo trabajo o anexa datos para un trabajo existente. Sólo
accesible cuando DataLog está activada. Si no se ha iniciado algún trabajo DataLog de
perforación, esta opción también se puede acceder desde la pantalla Localizar manteniendo
oprimido el gatillo y conmutando a la derecha. Página 8

Cargar trabajo – Carga los trabajos DataLog a una computadora con el software DigiTrak LWD
instalado. El localizador puede almacenar un máximo de 50 trabajos DataLog. Página 25

Ver DataLog – Muestra datos para un trabajo específico. Página 20

Ver / eliminar datos de varillas – Muestra todos los puntos de los datos registrados; le permite
eliminar el último punto de datos registrado. Página 20
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Apéndice B: Menús

Muchos de los comandos demenú LWD 3.04 son similares a los utilizados en otros programas deWindows,
y algunos tienen iconos asociados en la barra de herramientas. Sitúe el cursor en cualquier icono en LWD
para una descripción emergente que describe su función. Los iconos o elementos demenú que aparecen en
gris no pertenecen al archivo DataLog actual. Los números de página a continuación, se refieren a la primera
página en la que el comando semenciona en estemanual.

Menú "File" (Menú de archivo)
Símbolo Icono Descripción

New

(Nuevo) Crear un trabajo nuevo (datos de perforación, presión-
tensión o direccionamiento). Una vez que se ha realizado una
selección, aparece una nueva pantalla de trabajo en blanco.
Página 26

Open (Abrir) Abrir un trabajo existente. Página 29

Close – (Cerrar) Cerrar el trabajo actual.

Save
(Guardar) Guardar un trabajo abierto. Si el trabajo aún no ha sido
nombrado / guardado, esto abre la misma casilla de diálogo como
Save As (Guardar como). Página 45

Save As – (Guardar como) Guarde el trabajo actual en un nombre de archivo y
carpeta especificados. Página 45

Print Setup

(Configuración de impresión) Seleccione opciones tales como una
impresora, el tamaño y la orientación del papel. Estas opciones están
por lo general también disponibles en una casilla de diálogo de
Windows Print (Imprimir) bajo un botón llamado Properties
(Propiedades). Página 45

Print Preview (Vista previa a la impresión) Mostrar el trabajo en pantalla tal y como
aparecerá impreso. Página 45

Print (Imprimir) Imprimir el trabajo. Página 45

Export Spreadsheet
(Exportar hoja de cálculo) Exportar un archivo de texto de valor
separado por una coma (*.csv) para usarse en una hoja de cálculo.
Página 45

Export to KML – (Exportar a KML) Exporte el trabajo al formato KML para verlo en
Google Earth. Página 44

Upload Control (Control de carga) Enlace a un localizador DigiTrak para cargar
archivos. Página 25

File 1, 2... – (Archivo 1, 2…) Abrir un archivo abierto recientemente.
Exit – (Salir) Salir del programa DigiTrak LWD 3.0.
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Menú "Edit" (Menú de Editar)
Símbolo Icono Descripción

Site Information

(Información del sitio) Introduzca y edite la ubicación, información del
contacto y los comentarios que aparecen en la casilla "Site
Information" en la esquina superior izquierda del programa. Atajo:
haga doble clic en la casilla "Site Information". Página 30

Display Units

(Unidades en pantalla) Seleccione las unidades de profundidad,
inclinación, temperatura y presión que aparecen en las gráficas de
LWD. El ajuste de unidad de profundidad en el localizador
determinará las unidades mostradas. Página 29

Job Information

(Información del trabajo) Ver y editar los detalles del trabajo,
incluyendo la longitud de la varilla, la información del punto de
medición para archivos de datos de perforación y la información
sobre el producto que se está instalando para los archivos de la
presión-tensión. Esta casilla de diálogo se visualiza inmediatamente
después de cargar un archivo DataLog. Atajo: haga doble clic en la
casilla de "Job Information". Página 31

Utility Flags (Banderas de servicios públicos) Agregue, cambie o elimine
banderas y datos relacionados con los servicios públicos. Página 40

Flags and Pins (Banderas y alfileres) Editar, ocultar o comentar sobre banderas y
alfileres. Página 43

GPS White Lines (Líneas Blancas GPS) Importar o eliminar las Líneas Blancas.
Página 26

Profile Chart Annotations
(Anotaciones en el perfil altimétrico) Comente e inserte dibujos para
que aparezcan en el perfil altimétrico. Atajo: Arrastre sobre la gráfica
una casilla oprimiendo la tecla Shift. Página 41

Pressure Chart Annotations
(Anotaciones en la gráfica de presión) Comente e inserte dibujos
para que aparezcan en la gráfica de la presión. Atajo: Arrastre sobre
la gráfica una casilla oprimiendo la tecla Shift. Página 41

Profile Chart Properties (Propiedades del perfil altimétrico) Ajuste la escala del perfil
altimétrico. Página 41

Pressure Chart Properties (Propiedades de la gráfica de presión) Ajuste la escala de la gráfica
de presión. Página 41

Menú "View" (Menú Ver)
Símbolo Icono Descripción

Toolbar – (Barra de herramientas) Mostrar u ocultar la barra de herramientas.
Status Bar – (Barra de estado) Mostrar u ocultar la barra de estado.

Bluetooth Device List (Lista de dispositivos Bluetooth) Mostrar una lista de dispositivos
Bluetooth registrados. Página 26

Menú "Window" (Menú Ventana)
Símbolo Icono Descripción

NewWindow – (Ventana nueva) Abra el archivo actual en una nueva ventana.
Cascade – (Cascada) Organizar las ventanas en forma superpuesta.
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Símbolo Icono Descripción

Tile – (Mosaico) Organizar las ventanas en mosaicos no superpuestos.
Arrange Icons – (Organizar iconos) Organizar iconos de ventanas minimizadas.
Window 1, 2... – (Ventana 1, 2…) Ir a una ventana especificada.

Menú "Help" (Menú de ayuda)
Símbolo Icono Descripción

Help Topics (Tópicos de ayuda) Un índice de tópicos de ayuda. Página 29

About DigiTrak LWD – (Acerca de DigiTrak LWD) Muestra el número de versión del software
DigiTrak LWD.



DIGITAL  CONTROL  INCORPORATED

Manual delOperador LWD 3.04 DigiTrak 53

Apéndice C: Muestra Impresa del Resultado
Datos del cliente
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Gráficas de perforación y presión
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Tabla de datos
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Banderas y alfileres

Los datos de unmódulo iGPS aparecerían en las columnas Latitud, Longitud, Tiempo GNSS, y Distancia X GNSS.
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Banderas y alfileres (continuación)

Tenga en cuenta los comentarios añadidos al Alfiler en la Varilla 41.
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Tabla de la presión del fluido
Este informe será generado si los datos de presión del fluido están disponibles.
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Garantía estándar de DCI

DCI garantiza que reparará o reemplazará cualquier producto que no funcione de conformidad con lasespecificacionespublicadasde DCI al
momento de su envío debido a un defecto en losmateriales o lamano de obra durante el período de garantía para dicho producto, con sujeción a
los términosestipuladosmásabajo.

Categoría Período de Garantía

Transmisores Falcon (19" y 15") Tres años desde la fecha de compra o las primeras 500 horas de uso, cualquiera
suceda primero.

Todos otros transmisores Noventa días desde la fecha de compra

Localizadores, pantallas remotas,
cargadores de baterías y baterías
recargables

Un año desde la fecha de compra

Software* Un año desde la fecha de compra

Otros accesorios Noventa días desde la fecha de compra

Servicio/Reparación Noventa días desde la fecha de reparación

* Para software, en lugar de la garantía indicadamás arriba, DCI garantiza que actualizará cualquier software defectuoso demodo que se logre
cumplimientomaterial con las especificaciones de DCI para dicho software, o reembolsará el precio pagado por el software.

Términos
l El período de garantía de 3 años / 500 horaspara un transmisor Falcon está sujeto a que la adquisición se registre con DCI dentro de 90

díasde la fecha de compra.Si el cliente no registra la compra dentro de ese plazo, el período de garantía del transmisor será, en cambio, de
noventa díasdesde la fecha de compra.

l La cobertura de garantía para un transmisor de recambio bajo garantía se relaciona con el transmisor o transmisoresoriginales
presentadospara cobertura de garantía. Por ejemplo, si un transmisor Falcon ha sido de su propiedad durante un año yha sido utilizado
durante 250 horas, la cobertura de garantía para el reemplazo será de dosañosadicionaleso 250 horasadicionales, cualquiera suceda
primero.

l Para los propósitos de la garantía de los transmisoresFalcon, "horasde uso" significa horasde funcionamiento activo, segúnmidan
internamente los transmisoresFalcon.

l En caso de presentarse un reclamo válido bajo garantía, la elección de la solución (por ejemplo, reparar o remplazar un producto
defectuoso o, en caso de software defectuoso, actualizar o reembolsar) será a discreción exclusiva de DCI. DCI se reserva el derecho a
utilizar piezasde reemplazo refabricadaspara reparaciones.

l Lasgarantías anteriores solamente se aplican a productosnuevosadquiridosdirectamente de DCI o de un distribuidor de DCI autorizado.

l La decisión final sobre si un producto cumple los requisitos para reemplazo bajo garantía será a discreción exclusiva de DCI.

Exclusiones
l Los transmisoresque hayan excedido la temperaturamáxima, según lo indicado por el sistema.

l Defecto o daño causado por mal uso, abuso, instalación incorrecta, almacenamiento o transporte incorrectos, negligencia, accidente,
incendio, inundación, uso de fusibles incorrectos, contacto con altas tensioneso sustanciasnocivas, uso de componentesdel sistema no
fabricadoso suministradospor DCI, falta de cumplimiento con elmanual del operador, uso que no sea el previsto para el producto u otros
hechosmásallá del control de DCI.

l Cualquier transmisor utilizado con una caja incorrecta, o daño causado a un transmisor debido a instalación incorrecta en una caja o
extracción de una caja.

l Dañosdurante el transporte a DCI.

mailto:dci@digital-control.com
http://www.digitrak.com/
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Cualquier modificación, apertura, reparación o intento de reparación de un producto o cualquier manipulación o remoción de cualquier número
de serie, etiqueta u otra identificación del producto, anulará la garantía.

DCI no asevera ni garantiza la exactitud o integridad de losdatosgeneradospor los sistemasde guía/localización de PDH. La exactitud o
integridad de estosdatospueden ser afectadaspor una variedad de factores, incluyendo (sin limitación) la interferencia activa o pasiva yotras
condicionesambientales, la insuficiencia de calibración o de uso apropiado del dispositivo yde otros factores. DCI tampoco garantiza, y se exime
de responsabilidad por la exactitud e integridad de losdatosgeneradospor cualquier fuente externa que se puedamostrar en un dispositivo DCI,
incluyendo (sin limitación) los datos recibidosdesde cualquier equipo de perforación PDH.

DCI podrá realizar cambiosen el diseño ymejorasen losproductosde vezen cuando. DCI no tendrá la obligación de actualizar ningún producto
de DCI previamente fabricado a fin de incluir tales cambios.

LO ANTERIOR ES LA ÚNICA GARANTÍA PARA LOS PRODUCTOS DE DCI (SALVO LA GARANTÍA PROLONGADA DE 5 AÑOS/750
HORAS PARA LOS TRANSMISORES FALCON DE 15/19"). DCI RECHAZA TODA OTRA GARANTÍA, EXPRESA O IMPLÍCITA,
INCLUSIVE, PERO NO LIMITADO A, LAS GARANTÍAS IMPLÍCITAS DE COMERCIALIZACIÓN Y APTITUD PARA UN PROPÓSITO
EN PARTICULAR, GARANTÍA IMPLÍCITA DE NO VIOLACIÓN Y CUALQUIER GARANTÍA IMPLÍCITA QUE SURJA DEL
FUNCIONAMIENTO, TRANSACCIONES O PRÁCTICA COMERCIAL, TODAS LAS CUALES SE RECHAZAN POR EL PRESENTE.

En ningún caso, niDCI ni nadie comprometido en la creación, producción, venta o entrega delProducto DCI ("socios"), será responsable por
cualquier daño originado por uso indebido o incapacidad para el uso delProducto DCI, inclusive, pero no limitado a daños indirectos, especiales,
incidentaleso consecuenteso por cualquier cobertura, pérdida de información, beneficio o renta, o basado en cualquier reclamación por ruptura
de garantía o de contrato, negligencia, estricta responsabilidad o cualquier otra teoría legal, aun cuando DCI sea advertida de la posibilidad de
tales daños. En ningún caso excederá la responsabilidad de DCI o sus sociosel precio de compra del producto.

Esta garantía no se puede ceder ni transferir. La garantía constituye la totalidad del acuerdo entre DCI y el comprador y no se podrá expandir ni
enmendar de ningunamanera salvo por DCI por escrito.

Demostraciones del Producto
El personal de DCI puede estar presente en una obra para demostrar el uso básico, las características y los beneficios de losproductosde DCI.
El personal de DCI sólo estará presente para demostrar un producto DCI. DCI no proporciona servicios de localización u otros servicios de
consultoría o contratación. DCI no asume ninguna responsabilidad para capacitar alUsuario o a cualquier otra persona, y no asume
responsabilidad alguna por la localización o cualquier otro trabajo realizado en un sitio de trabajo en el que el personal o el equipo de la DCI están
o han estado presentes.

Traducciones
Este documento esuna traducción de la versión original en idioma inglés. El propósito de esta traducción esayudar al usuario del producto. Si
existiera algún conflicto o diferencia en la interpretación de este documento yel original, regirá el original. Una copia de la versión original en
idioma inglés se puede encontrar en www.digital-control.com.

http://www.digital-control.com/
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